Agilent Technologies

Software Status Bulletin

QTOF/TOF Acquisition  QTOF/TOF Acquisition

Known Problem Report as of Apr 16 2014 1:37PM

This Software Status Bulletin (SSB) documents all known problems in the software
product designated above. The SSB is derived from Known Problem Reports (KPR)
which result from user problems that have been classified as documentation problems
or software defects. When a KPR is written, an identifying number is assigned to it,
and the KPR is added to the next edition of the SSB.

User inputs that have been classified as Enhancement Requests are not documented in
the SSB. User problems that have been submitted, but that have not been classified by
the time the SSB is generated are not included in the SSB.

How to use the SSB

When you experience a problem with a product, first check this SSB to see if the
problem has been reported already, and if there is a temporary workaround available
for the problem, or if the problem has already been fixed by a new revision. If the
problem is not listed in this SSB then you may wish to report it to the Response
Center or to your field support representative.

To determine if your problem is documented in this SSB, first look in the "Keyword
Index" section of the SSB. Under each keyword is a listing of one-line descriptions of
related KPRs. If any of these sound like yours, locate the KPR # in the "Known
Problem Reports" section of the SSB, and read the full KPR. The KPRs in the
"Known Problem Reports™ section are sorted by KPR #.

There are two sections in the SSB:
Keyword Index: This index is categorized by keyword. For each KPR there is a brief
description and a KPR #. A KPR may be associated with more than one keyword.



Known Problem Reports: This section contains KPRs, with all the available
information relevant to the problem. KPRs in this section are sorted by KPR #.

Keyword Glossary

Keyword Index

KPR#: 3229 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.02.00

Keyword:

One-line Description:
Method Pane Initialization Failure When Configured LC Device is Powered Off

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 3461 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.00
Keyword:

One-line Description:
Logbook: removing "Description” column messes up the page

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a



KPR#: 4545 Product: QTOF/TOF Acquisition  QTOF/TOF Acquisition B.02.00
Keyword:

One-line Description:
Column device would not come back after power outtage

Problem:

n/a

Temporary Solution:

The user must shutdown and restart AppUIl and engines to get the system working
again.

Fix Information:

n/a

KPR#: 5711 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.00
Keyword:

One-line Description:
CTC Validation in Worklist when CTC is configured but not connected

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 5732 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.00
Keyword:

One-line Description:
Cannot stop a run after clicking the pause button

Problem:
The user starts a Worklist run. Then the user clicks the Pause button. This results in all
the sample or worklist buttons (Start, Start Worklist, Stop, Pause) being grayed out.

This means that once the user chooses to Pause the worklist, it cannot be stopped and
the user must wait for the sample run to finish.

Temporary Solution:

n/a

Fix Information:

n/a



KPR#: 5751 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.01.03
Keyword:

One-line Description:
Unexpected error message should be clearer

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 5762 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.01.03
Keyword:

One-line Description:
Forced engine restart at initial installation

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 5962 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.01.03
Keyword:

One-line Description:
Real Time Reference Mass Indicators working when no reference mass ion selected

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 5963 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.01.03

Keyword:



One-line Description:
System should stop run with incorrect reference mass correction settings

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 5985 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition
Keyword:

One-line Description:
Wrong Polarity Settings Can Be Saved in Parameters Tab

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 7265 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition
Keyword:

One-line Description:
Column - Incorrect minimum temperature

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 8213 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition
Keyword:

One-line Description:
Redraw/Refresh Issues When Adding Signal To The Real Time Plot

B.01.03

B.02.00

B.01.01



Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 8236 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition
Keyword:

One-line Description:
Adjust Menu Item in Real Time Plot Not Consistantly Viewable

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

B.01.00

KPR#: 8316 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition
Keyword:

One-line Description:
CapPump: Fast Reconditioning setting is not remembered

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

B.01.01

KPR#: 8401 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition
Keyword:

One-line Description:
Binary Pump Missing from Acquisition Report Dialog List

Problem:
n/a
Temporary Solution:

B.01.01



n/a
Fix Information:
n/a

KPR#: 8493 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.01.00
Keyword:

One-line Description:
User Friendly Error Messages Need to be Given While Editing Segment Table

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 8671 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.01.00
Keyword:

One-line Description:
Proper Error Message Needs to be Given for Preferred/Exclude Table Fields

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 8688 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.01.00
Keyword:

One-line Description:
Sorting Using Collision Energy Column Does Not Work Correctly

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a




KPR#: 8708 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.01.00
Keyword:

One-line Description:
Over The Limit Values Are Not Highlighted Red When Importing MS Parameter Values

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 8709 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.01.00
Keyword:

One-line Description:
Invalid MS Parameter Values Are Not Highlighted Red After Worklist Import

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 8726 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.01.00
Keyword:

One-line Description:
Ref mass table can be imported with invalid characters

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 8740 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.01.01

Keyword:



One-line Description:
Usefull error messages need to be given for erroneous input in ref mass table

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 8762 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.01.00
Keyword:

One-line Description:
Name change for position 1 for 2 position can valve does not work.

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 8781 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.01.01
Keyword:

One-line Description:
Acquisition Method Report Does Not Show Specific Names Based On Device Models

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 9159 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.01.00
Keyword:

One-line Description:
Logbook Entry Not Clear When Disk Is Full

Problem:



n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 9264 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.01.00
Keyword:

One-line Description:
Min/Max Values Should Display When Wrong Entry Is Made In Method Pane

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 9285 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.01.00
Keyword:

One-line Description:
Intermitantly, The Q-TOF Icon Is Green When The Q-TOF Run State Is "Waiting"

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 9292 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.01.01
Keyword:

One-line Description:
button should put everything (including the chip) in standby position

Problem:

n/a

Temporary Solution:
n/a

Fix Information:



n/a

KPR#: 9319 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition
Keyword:

One-line Description:
Changing Pump Post Time During Run Is Ignored

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

B.01.00

KPR#: 9327 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition
Keyword:

One-line Description:
Values Along Y-axis In Optimization Panel Are Overwritten

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

B.01.01

KPR#: 9349 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition
Keyword:

One-line Description:
Real Time Plot Printout Needs Formatting

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

B.01.00

KPR#: 9381 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition

B.01.00



Keyword:

One-line Description:
Acquisition Rate and Time Changes When Run Starts

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 9442 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.01.01
Keyword:

One-line Description:
Quad Tune Does Not Turn Off The Calibrant If Quad Tune Fails To Complete

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 9546 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.01.01
Keyword:

One-line Description:
Auto-scale during negative mode quad tune is auto-scaling in Wide mode

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 9568 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.01.00
Keyword:

One-line Description:
Saving acquisition part of method to "Qual" Unified method



Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 9590 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.01.01
Keyword:

One-line Description:
Actuals are not always updated during AutoMSMS run

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 9621 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.01.01
Keyword:

One-line Description:
Higher calibration masses should be disabled when low mass range is selected

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 9622 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.01.01
Keyword:

One-line Description:
Calibrant dropout during calibration

Problem:
n/a
Temporary Solution:



n/a
Fix Information:
n/a

KPR#: 9638 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition
Keyword:

One-line Description:
Incorrect Error Message When Q-TOF Check Tune Fails

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

B.01.02

KPR#: 9639 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition
Keyword:

One-line Description:
When Tune Report Is Closed, Upon Reopening the Report Fails To Open

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

B.01.00

KPR#: 9692 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition
Keyword:

One-line Description:
Performance problem for loading method with long table

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

B.01.02




KPR#: 9693 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition
Keyword:

One-line Description:
Incorrect mass range for MS1 data storage

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

B.01.02

KPR#: 9736 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition
Keyword:

One-line Description:
Default APCI VCap incorrect in Acquisition

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

B.01.02

KPR#: 9743 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition
Keyword:

One-line Description:
System Log: "Cannot find parentld structure: Parentld=<>; ChildID=<>"

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

B.01.02

KPR#: 10254 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.01.02

Keyword:



One-line Description:
TOF Vacuum not updating in Instrument Actuals

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 10271 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.01.00

Keyword:

One-line Description:
Incorrect MS2 precursor m/z for targeted mode

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 10548 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.02.00

Keyword:

One-line Description:
Incorrect mass displayed when using high/low fragmentor for second signal

Problem:

If the user creates an experiment with two scan experiments (one low fragmentor and
one high fragmentor) in negative ion mode. The first scan will display the correct
masses. The second scan will display masses that are 5 to 10 daltons off.
Temporary Solution:

n/a

Fix Information:

n/a

KPR#: 11204 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.01.02



Keyword:

One-line Description:
Double click required when changing time segment time

Problem:

When you add a time segment, if you click only once on the time, you cannot edit or
change the time. If you double click, you can now change the time. This is completely
opposite with all the other variables on the screen. All other setpoints require that you
only be in the field to edit their value.

Temporary Solution:

n/a

Fix Information:

Fixed

KPR#: 11256 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.01.02

Keyword:

One-line Description:
MassHunter crashes when ALS tray is not installed

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 12308 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.01.03

Keyword:

One-line Description:
Printing after a tune print preview hangs Excel 2007

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a



KPR#: 12560 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.01.03

Keyword:

One-line Description:
Bad Autotune file causes loss of commication

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 12910 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.01.03

Keyword:

One-line Description:
TOF customer needs to be able to set neb pressure to 0 psi

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 13227 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.01.03

Keyword:

One-line Description:
TOF customer requests serial number on tune report

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a




KPR#: 13450 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.01.03

Keyword:

One-line Description:
"Software Not Responding” Error Message Not Correct

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 13791 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.02.00

Keyword:

One-line Description:
Instrument Mode Not Display in Instrument State Tab after Tune

Problem:

The instrument was tuned in 2 GHz mode. It passed with issues. However, upon
completion, the icon shows the mode that the instrument is in. But on the instrument
state tab, the instrument mode radio buttons are all cleared.

Temporary Solution:

n/a

Fix Information:

n/a

KPR#: 13932 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.02.00

Keyword:

One-line Description:
Typing "." into time filed of external contacts tab shuts down Ul

Problem:

-install the external contacts board into WPS

-select the external contacts and select the WPS/external contacts tab.
-insert a line into the table

-enter ".5" into the time column.



the Ul shuts down.
Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 13933 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.02.00

Keyword:

One-line Description:
only Contact 1 is visible in External Contacts tab

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 13950 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.02.00

Keyword:

One-line Description:
Temperature in Tune Context for Sheath Gas is Changing

Problem:

In the Tune context, if you set a sheath gas temp of 375, the Ul will change it to 380. If
you then reenter 375, the setting takes. This has not been observed in the acquisition
context.

Temporary Solution:

n/a

Fix Information:

n/a

KPR#: 13980 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.02.00

Keyword:

One-line Description:
Solvent Selection Valve Needs to be Actively Controlled in Acquisition



Problem:
In the current acquisition software, the solvent selection valve is not active when the run
is not active. Users migrating from A.02.XX to the B.02.XX loose this important feature.

Multiple users have already requested that the selection valve be actively control and
switch when they change the position in the acquisition software.

As we get more users on the B series MassHunter, more are going to want this
functionality.

Temporary Solution:

n/a

Fix Information:

n/a

KPR#: 14085 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.02.00

Keyword:

One-line Description:
Autotune window switches from mass to time without provocation

Problem:

During initial auto tune schedule window switches into time scale at the beginning of the
detector gain module without any provocation. After that tune stops because of the
system confusion.

Temporary Solution:

n/a

Fix Information:

n/a

KPR#: 14118 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.02.00

Keyword:

One-line Description:
Fast Polarity Switching tunes are performed at the wrong frequency

Problem:

All fast switching tunes should be performed at 2 scans/sec. We need to give customers
at least the same performance as A.02.02.

Temporary Solution:

n/a

Fix Information:



n/a

KPR#: 14177 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.02.00

Keyword:

One-line Description:
Concurrent Qual execution of Acquisition Method Report and Tune report fails

Problem:

n/a

Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 14218 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.02.00

Keyword:

One-line Description:
Data collected in FIA mode cannot be opened in Qual

Problem:
Data collected in FIA mode cannot be opened in Qual.

A user reported that they collected their data using an injector program. While the data
is collected and written to disk. However, when the data is opened, Qual crashes with
an error "Retention time values must be unique”. Data has been collected and the
defect is absolutely reproduceable.

Temporary Solution:

n/a

Fix Information:

This issue was fixed in the B.02.01 release build 2116.

KPR#: 14219 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.02.01

Keyword:

One-line Description:
Mulitple Injections will fail

Problem:



The user was doing runs with multiple injections in one data file. MS Mass failed
because each injection also restarts the MS Mass.

Temporary Solution:

n/a

Fix Information:

n/a

KPR#: 14238 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.02.00

Keyword:

One-line Description:
G6224A/G6230A Autotune report shows incorrect rough vac and TOF vac

Problem:

G6224A/G6230A Autotune report shows incorrect rough vac and TOF vac
Temporary Solution:

n/a

Fix Information:

This defect was fixed with the release of B.02.01.

KPR#: 14276 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.02.01

Keyword:

One-line Description:
Customer Requires Time Segments Shorter Than 30 Seconds

Problem:

A TOF customer with a RRLC has a total run time of 1 minute. They want the first 6
seconds of the run to be sent to waste. However, with TOF and QTOF, time segments
shorter than 30 seconds are not allowed. For this customer, it is a critical defect. This
was confirmed by another customer in Southern California running the same
configuration.

Temporary Solution:

This will be fixed in a pending service release for MassHunter Acquisition B.02.01.

Fix Information:

n/a

KPR#: 14277 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.02.01

Keyword:



One-line Description:
Uninstall does not remove Quant Add-in from Excel 2007

Problem:
Observed by software tester:

-uninstalled Acq, Qual, Quant and Quant Reporting.
-re-installed in following order.

Acq

Qual

Quant

Quant Reporting

-ran Autotune and got a "File could not be accessed..." message when tune reoprt was
generated:

There was also an error when opening Excel.

Temporary Solution:

Workaround is to open Excel, manually remove the add-in, close Excel and re-open it.
Problem is fixed.

Fix Information:

n/a

KPR#: 14278 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.02.01

Keyword:

One-line Description:
MassHunter Fault prioritization

Problem:

When the instrument has a fault, the main board automatically shuts the high vac gauge
off and that results in an insufficient vacuum. Mass Hunter always displays
"InsufficientVaccum” and doesn't show the primary instrument fault.

Could the faults be prioritized such that the primary fault is always the one displayed
rather than the insufficient vaccum.

Temporary Solution:

n/a

Fix Information:

n/a

KPR#: 14279 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.02.01

Keyword:



One-line Description:
Acquisition should report fault when Injection volume is larger than syringe

Problem:

Changed syringe volume from 40ul to 8 ul in the configuration of the uWPS.

Left the method injection volume at 40 ul.

Save the method.

Reloaded the method per the warning mesage.

The method should now be bad for the injection volume since the syringe volume is 8 ul
but the injection volume is 40 ul.

Saved method.
Temporary Solution:
n/a

Fix Information:

n/a

KPR#: 14280 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.02.01

Keyword:

One-line Description:
Tunes Still Appear When They Should Not With MMI

Problem:
Testing tune functions with the MMI Source on 6530.

For TOF, Standard Tune, Set Detector Gain, Initial Tune still are possilble. This is
supposed to be greyed out and not possible. This is with the instrument in 2 GHz mode.
Temporary Solution:

When the user tries to run the Autotune with one of the unsupported source types, the
Autotune will stop with an error and will not proceed.

Fix Information:

n/a

KPR#: 14281 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.02.01

Keyword:

One-line Description:
Missing Items in the Acquisition Report

Problem:



In the acquisition report, there are several issues that need to be fixed.

1) In the device list, the Model Number, Serial Number, Firmware Revision should be
included on the report. This information is readily available in the "Instrument
Configuration Report". The information in the acquisition report should be identical.

2) On the DAD, it does not indicate which DAD signal is being stored.

3) "Scan Source Parameters" is confusing. The labels for the different sections should
match the software.

Temporary Solution:

n/a

Fix Information:

n/a

KPR#: 14282 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.02.01

Keyword:

One-line Description:
Cap current readback is always 10uA on 6530A

Problem:

The Cap Current actual field always displays 10, the value never changes.
Temporary Solution:

Until the Vcap/Vcham power supply is updated to the newest version, this is the
readback that the user will see.

Fix Information:

n/a

KPR#: 14283 Product: QTOF/TOF Acquisition QTOF/TOF
Acquisition B.02.01

Keyword:

One-line Description:
QTOF Icon remains RED after power cycle and Instrument Actuals is not correct

Problem:
The user had to power cycle the instrument.

After the power cycle, the QTOF icon remained RED and the Instrument Actuals said
"The instrument is not responding”. However, once the firmware was ready (rebooting
from power cycle), the user could turn the instrument on and tune.

Temporary Solution:



The user must shutdown the Acquisition software and then restart it. This will refresh
the user interface and the status will be correct.

Fix Information:

n/a

KPR#: 14285 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.01

Keyword: RTP report printed from screen does not show page numbers One-line
Description:

Problem:

Select File/Print RTP report Select "screen” Print the report from Explorer. The pages
are not numbered. This happens only in portrait mode, the pages are numbered when
landscape is selected. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14286 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.01

Keyword: TOF analysis report should not show collision energy One-line Description:

Problem:

Collision energy should be removed from the TOF chromatograms on the analysis
reports. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14287 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.01

Keyword: Instrument state should be the same on TOF and Quad tune reports One-
line Description:

Problem:

The instrument state for the TOF tune is "2 GHz HiGain", on the Quad tune report it is
"Ext Dynamic Range (2GHz)" They should both be the same, "Ext Dynamic Range
(2GHz)". Temporary Solution:

n/a Fix Information:



n/a
KPR#: 14289 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.01

Keyword: Isolated peak on RTD turns into triangle at the beginning of the tune One-
line Description:

Problem:

If the user at the beginning of a tune zooms the right Real Time Display to a single
peak, then at the beginning of a tune this peak turns into a 8 amu width triangle and
transfered this way into the report. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14290 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.01

Keyword: User needs to know correct input range for source parameters. One-line
Description:

Problem:

Currently the user has no way of knowing what the correct input ranges are for the
source parameters in Acquisition. In Acquisition, enter 600 into the Gas Temp field and
click You get a message saying the MS QTOF tab has errors but the message does not
tell you what the error is and how to correct it. The message should be more specific
and tell you the correct inpur range or there should be a right-click menu that displays
the min/max/default values for that field. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14291 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.01

Keyword: Logbook does not capture "Lamp Ignition Failure" nor does it report a
fault One-line Description:

Problem:
The user was starting a run with all the modules in standby or off. When the VWD lamp
was turned on, it failed to ignite. This error is captured and reported by ChemStation.



However, it does not appear in either the VWD: Not Ready Text Long or the
MassHunter Acquisition logbook. The VWD module icon turns RED but fails to report
anything to the user. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14292 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.01

Keyword: Initial TOF Tune Stuck In An Endless Loop One-line Description:

Problem:

While performing an initial TOF tune on a 6230, the tune got stuck in an endless loop at
the detector gain step => Adjust PMT. The gain curve looked correct. But the software
kept looping. To stop it, the Abort button was pushed. Subsequently, another initial TOF
Tune showed negative peaks indicating something is not right with the acquisition
board. Temporary Solution:

The user should examine the Acquisition Logbook for any faults that might be causing
the loop condition. It is possible an instrument fault is causing the problem but the Auto
Tune program is not able to stop with a fault. Fix Information:

n/a

KPR#: 14293 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.01

Keyword: Voltage error in Bottom Slit One-line Description:

Problem:

A large error in the output voltage of the bottom slit was observed on two instruments.
The output voltage error was more than 3 V on one instrument and 2.5 V on the second
instrument. The top and bottom slits are typically set to within 0.5 V difference. These
elements are very sensitive to incorrect voltage set points. A 3 V difference between the
two lenses could completely shut down the abundance. In both cases, Initial autotune
could not complete because of not enough abundance. Temporary Solution:

Both of these instruments had defective mainboards. Once the mainboards were
exchanged, the problems disappeared. Fix Information:

n/a

KPR#: 14295 Product: QTOF/TOF Acquisition  QTOF/TOF Acquisition B.02.01

Keyword: Incorrect indication of the fault One-line Description:



Problem:

Short circuit in the ion focus lens created a fault named as "Collision Cell shroud
fault” Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14296 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.01

Keyword: TOf Energy Offset field accepts values outside the limit. One-line
Description:

Problem:

In Tune, under Optics 2, the field "TOf Energy Offset" checks the range for entered
values and the field turns red when an invalid value is entered, but no message box is
shown and the value is accepted. Temporary Solution:

User should be aware when manually tuning the system that some field can change
which can result in a loss of ions or a bad set point. To recover from this state, an Initial
TOF tune should be run. Fix Information:

n/a

KPR#: 14297 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.01

Keyword: Lower limit is incorrectly shown in message box for many fields. One-line
Description:

Problem:

The acceptable lower limit for many fields seems to have changed to 0 from negative
values. There are many fields which only accept O or higher values, but the message
box still gives a range of (example) - -600 to 600. Some of the fields tested include:
Fragmentor Skimmer Octl DC Oct2 DC Lens 1 lens 2 Horiz Q Vert Q Top Slit Bot

Slit Temporary Solution:

If the user is manually tuning the system, the user should be aware of the polarity of the
element being changed and the impact on the ion beam when that element has the
wrong polarity voltage applied to it. To recover, the user should run an Initial Tune. Fix
Information:

n/a



KPR#: 14298 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.01

Keyword: User should be prompted to disable FPS when manually performing Quad
profiling One-line Description:

Problem:

With Fast Polarity Switching (FPS) enabled, the user switched to Manual Tune. They
then selected the Quad tab and started manually profiling the tune ions. When they
couldn't see any profile peaks, they realized they should have disabled FPS. The user
should be prompted to disable FPS when they start to profile. Temporary Solution:
The user should not perform Quad Profiling with Fast Polarity Switching enabled. Fix
Information:

n/a

KPR#: 14299 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.01

Keyword: Source type is incorrect on quad tune report One-line Description:

Problem:

The source type is reported as "ESI" when it should be ESI+Agilent Jet
Stream. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14300 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.01

Keyword: "Error 0" when "no" is clicked to "ok to continue" prompt in Autotune One-line
Description:

Problem:

Start an initial autotune with the AJS and fast polarity switching. After positive mode
click "no" in the ok to continue prompt. A box appears with "error 0". Temporary
Solution:

Allow the full set of tunes complete. Fix Information:

n/a



KPR#: 14301 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.01

Keyword: Quick Tune in High Res Mode shows 4GHz (high res disabled) results One-
line Description:

Problem:

TOF tunes other than CheckTune disabled HiRes if it's on for the duration of Autotune.
CheckTune consistently does report HiRes if HiRes is on. QuickTune (and everyone
other TOF Autotune) disabled HiRes and does not re-enable it prior to generating a
report. After doing an initial autotune in extended mode, if a checktune or quick tune in
done in 4 GHz high res mode, the report generated for the tune will report values for 4
GHz (non high res) rather than for 4 GHz (high res mode) This results in the resolution
values being reported much lower than were actually obtained in the high res tune. This
has also been reported from 2 recent installs at customer sites for 6220 instruments
with software rev B.02.00 with patch 2. Temporary Solution:

Quick Tune performs a tune which disables High Resolution Mode. This is normal. To
get a tune report in High Resolution Mode, only the Checktune will provide the desired
report. Fix Information:

n/a

KPR#: 14302 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.01

Keyword: Acquisition loses MS traces in real time display after worklist error and
restart One-line Description:

Problem:

The user was running a worklist which paused because a vial was missing. He put a vial
in the correct position and resumed the worklist. The real time display showed the pump
pressure, the run time clock was increaseing, and the spectral display in the right upper
corner was incrementing to the correct time. However, no MS chromatographic
information (TIC and BPC in this case) was shown in the real time display, and the run
time was incorrect. The data were written correctly to disk, so this is a problem with the
real time display. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14303 Product: QTOF/TOF Acquisition  QTOF/TOF Acquisition B.02.01

Keyword: Nozzle voltage cannot be shown in Actual Parameters One-line
Description:



Problem:

Nozzle voltage for Agilent Jet Stream does not appear in the list for Parameters Actual
for TOF QTOF, so it cannot be monitored. All other parameters in the tab appear in this
list and so can be monitored as their value is changed during e.g., time

segments. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14304 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.01

Keyword: Data Acquisition Baseline is offset after changing mode of operation One-
line Description:

Problem:

Sometimes when an operator changes 1 GHz to 2 GHz, reverses polarity, or a high
voltage arc over event occurs, the baseline is offset 600,000 counts or higher.
Occansionally, the baseline can be restored by changing mode of operation back and
forward. (1 GHz- 2 GHz). Temporary Solution:

The user must restart the Acquisition software and possibly the Q-TOF or TOF itself.
This will be address in a service release. Fix Information:

n/a

KPR#: 14305 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.01

Keyword: Detector gain report is titled "TOF CheckTune" One-line Description:

Problem:

The detector gain report is titled "TOF CheckTune" Temporary Solution:
n/a Fix Information:

n/a

KPR#: 14306 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.01

Keyword: Chip Cube Time Table Is Clearing Upon New Chip Being Loaded One-line
Description:



Problem:

Chip cube time table is being cleared when the chip is unloaded and a new one is
installed. Here is the configuration: HPLC Chip Stack 6530 With a chip loaded, 1)
Create a method with a time table in the chip cube method settings. 2) Save the
method. Leave the Chip Cube Time Table visible. 3) Eject the chip 4) Install a new chip
(it can be identical type) and select Operate from the Chip Cube Icon. 5) Times in Time
table remain but the Inner Valve positions are all changed to Enrichment for all time
table entries. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14307 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.01

Keyword: Slicer current measurement causes electronics fuses to blow One-line
Description:

Problem:

On a 6530, the instrument does not have ions. The FSE does a slicer current
measurement. The FSE then hears a load bang as the electronics fuses blow and the
instrument vents. Afterwards, the AC board must be replaced because the heaters
relays are destroyed. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14308 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.01

Keyword: Unplugging Vaporizer Heater Cable with AJS Causes Unrecoverable
Nebulizer Fault One-line Description:

Problem:

While trying to fix an instrument, the vaporizer heater cable was unplugged with the
Agilent Jet Stream. This caused a nebulizer timeout error from which the firmware could
not recover. The solvent selection valve started switching every 15 seconds or so. If you
looked at the back door, the firmware was trying to recover the fault but never could. It
took a power cycle of the instrument AND restarting MassHunter Acq plus engines to
recover. Temporary Solution:

n/a Fix Information:



Fixed
KPR#: 14309 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.03.01

Keyword: Aborting Initial TOF Tune Resets The Quad AMU To Default One-line
Description:

Problem:

User had completed all TOF Tunes and Quad Tunes. They then started another Initial
TOF tune but then aborted autotune immediately. After aborting, there were no high
mass ions. After some verification of setpoints, the user then looked at Quad AMU. It
was set to 120. User had to run Positive lon TOF tune again. Temporary Solution:
User can simply reload a backup tune file or look at the tune reports directory on
D:\MassHunter\Tune\QTOF\Reports to find a good tune report. The user will then have
to manually reenter the tune values. Fix Information:

n/a

KPR#: 14310 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.03.01

Keyword: "Quick" operations in tune can have bad consequences One-line
Description:

Problem:

User started a quad tune then immediately cancelled the operatioin, closed the
operation cancelled prompt started it again immediately than cancelled. User then tried
to start the Quad Tune again but found that no buttons were responding in the tune
tabs. They tried to switch to Acquisition context but was balked with "Failed to switch
context. One of the tune processes is currnetly running and must not be

interrupted.” Temporary Solution:

Run the Process Cleaner to restart the engines and user interface. Fix Information:
n/a

KPR#: 14311 Product: QTOF/TOF Acquisition  QTOF/TOF Acquisition B.03.01

Keyword: No error message reported when out of range entry is made into TOF/Mass
Range fields One-line Description:



Problem:

-go to manual tune -select the TOF tab -make an invalid entry in one of the mass range
fields. The field turns red but there is no error message that gives the valid range for the
field. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14312 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.03.01
SP2

Keyword: "ChosenAutotuneParametersRootNode is nothing" fault appears in Chip
Cube when switching to tune context One-line Description:

Problem:

Customer installs Diagnostics and Calibration chip while in Acquisition. Then switches
to Tune context. As soon as entering Tune, the error
"ChosenAutotuneParametersRootNode is nothing" appears. The system calibrates but
then does not turn off the calibrant and the calibrant bottle runs dry. Temporary
Solution:

n/a Fix Information:

Fixed in B.04.00 release of software

KPR#: 14314 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.01

Keyword: 20,000 mass range does not work with 2.113 for G6520A One-line
Description:

Problem:

A customer reported that when they selected Minimum File Size AND selected the
20,000 mass range that the instrument stopped displaying spectra and would not
acquire data. Temporary Solution:

Roll the firmware of the G6520A back to 2.110. Fix Information:

Fixed with the release of B.04.00 MassHunter Acquisition software.

KPR#: 14315 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.04.00

Keyword: .NET 3.5 Installer does not check if software is already installed. One-line
Description:



Problem:

The landing page for QQQ B.04.00 has a button for installing .NET 3.5. Clicking this
button runs the installer for .NET 3.5. However, if .NET 3.5 is already installed, it still
goes ahead to uncompress the installer, pops up dialog asking user to accept the
licensing and then the wizard shows "Setup Error". This is confusing to the user who
doesn't know if there is a problem. Temporary Solution:

The error reported means that the .NET 3.5 software is already installed. Fix
Information:

n/a

KPR#: 14316 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.04.00

Keyword: Nebulizer Supply Fault When Switching Between Acquisition and Tune
Context One-line Description:

Problem:

When switching between acquisition and tune context with Agilent Jet Stream, if there is
greater than 15 psi difference in the nebulizer pressures, the instrument will fault with a
nebulizer fault. When doing this in support lab, the nebulizer pressure does not drop
correctly. It sits at 35 psi for 30 seconds and then drops 1 psi every 10 seconds or so.
Then the instrument faults. The instrument recovers but continues to fault even in
standby because the standby pressure (20 psi) cannot be obtained. The same thing has
been reported in B.02.01 SP3. Temporary Solution:

Defect has not been reproducible. Faulting of the firmware has been modified such that
the instrument will recover from the nebulizer fault. However, if the instrument will not
recover, simply power cycle the instrument. The MassHunter Acquisition software does
not need to be restarted. Fix Information:

n/a

KPR#: 14317 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.04.00

Keyword: Drying Gas flow rate can not be set less than 3.5L/min One-line
Description:

Problem:
Drying Gas flow rate can not be set less than 3.5L/min, for some Chipcube
configurations we recommend 2.5L/min Temporary Solution:



n/a Fix Information:
This defect was fixed with the release of Service Pack 3 for MassHunter Acquisition for
TOF and QTOF B.04.00

KPR#: 14318 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.01
SP1

Keyword: "Please Load Chip Message" with Chip Cube and B.02.01 SP1 One-line
Description:

Problem:

It has been observed on two QTOF systems in the support lab and is now being
reported by a collaborator customer. Here is the defect: After SP1 installation (and it
may not be directly related to SP1) a chip cube will not recognize the installed chip. The
Ul reports to the user "Please Load Chip" even though there is a chip installed and it is
operate mode. If you try to read the chip details, the menus are greyed out. To get the
chip read, MH Ul and engines must be shut down and restarted. Then the chip details
can be read and the Ul reflects that the chip is installed. However, the user can never
eject the chip or the entire process must be redone to get the chip reread. Temporary
Solution:

n/a Fix Information:

This defect has been fixed with the release of SP3 for B.02.01 and SP2 for B.03.01.

KPR#: 14319 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.01
SP1

Keyword: G4226A 1290 ALS has no illumination option One-line Description:

Problem:

Reported by a FSE in Japan: lllumination: G4220A pump had illumination. But G4226A
ALS had no illumination. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14320 Product: QTOF/TOF Acquisition  QTOF/TOF Acquisition B.04.00

Keyword: Quad Tune Fails Intermitantly One-line Description:



Problem:

It has been observed that on certain 6538 and 6540 instruments, that the Quad Tune
(Initial usually) will fail. The Quad Tune will start and ions will be shown in the real time
window. However, at some point, the real time window stops displaying ions. When
investigated, the peaks can be found by manually adjusting the quad values. The
instrument will show poor resolution and poor mass assignments. Temporary Solution:
The user needs to restart the Initial Quad Tune. This will resolve the problem in almost
every case. Further investigations are ongoing. A patch will be created once the
problem is identified. Fix Information:

n/a

KPR#: 14321 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.04.00

Keyword: Incorrect Fault Message When Excel 2010 Is Missing One-line Description:

Problem:

While performing testing, the acquisition software was loaded. An error appeared and
reported that "Excel 2007 was not detected". This test was for the Win 7 x64 load of the
software. This error message needs to report that "Excel 2010 was not detected". It
makes the software appear to not be complete. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14322 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.04.00

Keyword: Wrong DSP Firmware On The MassHunter Acquisition B.04.00 Release
Media One-line Description:

Problem:

The wrong DSP firmware for the TOF and QTOF has been found in the release
firmware. This problem affects all 6224 and 6230 TOF LC/MS Systems AND all
G6520A, G6520B, G6530A, G6538A, and G6540A Q-TOF LC/MS Systems. Users will
find that some of these instruments will start showing "Serial Link Timeout"

errors. Temporary Solution:

n/a Fix Information:

This defect was fixed with the release of SP1 for MassHunter Acquisition for TOF and
Q-TOF B.04.00.



KPR#: 14323 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.04.00

Keyword: Fast Polarity Switching Signal Drop Out For A Single Data Point During Long
Runs One-line Description:

Problem:

It has been observed that during long runs with Fast Polarity Switching active, that
some instruments will loose a single data point in the chromatogram. This appears to
the user as a data point with no data in the chromatogram. Some instruments show this
behavior more than others. It has been observed on G6520B Q-TOF LC/MS Systems.
However, it may affect other TOF or Q-TOF LC/MS instruments as well. Temporary
Solution:

n/a Fix Information:

It was found that there was a defect in the DSP code of the LC/MS TOF or Q-TOF
firmware. Customers who experience these drop outs with either B.02.01 or B.03.01
must upgrade their software to B.04.00 SP1 or higher to fix this problem.

KPR#: 14324 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.04.00

Keyword: Calibration Fails During Initial Autotune One-line Description:

Problem:

It has been observed that with the very first attempt at autotune, the calibration will fail.
If the user restarts the Autotune, it will run without issue. The calibrant spectrum will be
valid and all masses appear to be present. This seems to happen when the low mass
(100-600 amu) has lots of chemical noise where the calibrant masses for 118 and 322
are lower in abundance than the chemical noise. This has also been observed on TOF
systems where the abundances are very high. The lower half of the spectrum is super
high abundance and the high mass is much lower. The contaminant peaks in the low
end then (even on a *relatively* clean instrument) become a problem because they
overwhelm the calibrant peaks, and we see the message about not finding enough
calibrant peaks. The reported error is "Error -1: Calibration Masses not

found". Temporary Solution:

n/a Fix Information:

This defect was fixed with the release of SP1 for MassHunter Acquisition for TOF and
Q-TOF B.04.00.

KPR#: 14325 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.04.00

Keyword: Oct 2 RF Voltage Appears In lon Focus Field One-line Description:



Problem:

While running some tests, it was found that in the Manual Tune tab => Optics 2 tab that
for lon Focus, it is displaying 750V. This is not possible. This is the Octopole 2 RF
voltage which is not even used on the 6540 and 6538. This has been confirmed on two
different systems. Temporary Solution:

n/a Fix Information:

Fixed with release of SP1 for MassHunter Acquisition for TOF and Q-TOF B.04.00

KPR#: 14326 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.04.00

Keyword: Dual AJS ESI source does not produce the correct sheath gas temps and
pressure One-line Description:

Problem:

Testing has revealed that Dual AJS ESI source does not produce the correct sheath
gas temps and pressure. The sheath gas temperature and pressure should be the same
as those for the AJS source. This issue occurs in firmware build 10.422. Temporary
Solution:

n/a Fix Information:

This defect was fixed with the release of SP1 for MassHunter Acquisition for TOF and
Q-TOF B.04.00.

KPR#: 14327 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.04.00

Keyword: Error Message "Failed to write Non-MS Data Curves to Data File" Appearing
On TOF/Q-TOF Systems One-line Description:

Problem:

Customers have reported that the error "Failed to write Non-MS Data Curves to Data
File" are appearing. The customers are reporting that they are not storing any LC Data
Curves. This halts the worklist and customers cannot acquire any data. Temporary
Solution:

n/a Fix Information:

This defect was fixed with the release of Service Pack 1 for MassHunter Acquisition for
TOF and Q-TOF B.04.00 Build 4033.



KPR#: 14328 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.04.00

Keyword: Wrong default scan rate after tune completed One-line Description:

Problem:

Default scan rate in initial autotune is 0.61 or 0.71 scan/sec. This means that the
acquisition rate for the tune is not correct which could result in a poorly tuned
instrument. Temporary Solution:

n/a Fix Information:

This defect was fixed with the release of Service Pack 1.

KPR#: 14329 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.04.00

Keyword: Tune Report Does Not Have Vertical Q or Oct2DC Numbers One-line
Description:

Problem:

The Initial TOF tune report in G6224A does not have Verrtical Q voltage value printed
on the tune report. Further investigations have shown that this defect affects all
supported TOF models with the B.04.00 Acquisition Software. Temporary Solution:
n/a Fix Information:

This defect has been fixed with the release of Service Pack 1 for MassHunter
Acquisition for TOF and Q-TOF B.04.00.

KPR#: 14330 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.04.00

Keyword: Autotune Final Calibration Takes Too Long One-line Description:

Problem:

Autotune pauses for unexpected amount of time during final calibration. It was found
that a feature was enabled that was not supposed to be enabled. Temporary Solution:
n/a Fix Information:

This defect has been fixed with the release of Service Pack 1 for MassHunter
Acquisition for TOF and Q-TOF B.04.00.

KPR#: 14333 Product: QTOF/TOF Acquisition  QTOF/TOF Acquisition B.05.00



Keyword: A Long Worklist Stopped With "Instrument is sending more spectra than SW
can accept” One-line Description:

Problem:

The worklist contained long and short methods. It stopped after ~ 24 hours while
executing a long (40 minute) negative method. The message in logbook was
"instrument is sending more spectra than SW can accept..." Temporary Solution:

This error occurs whenever the hard drive of the computer is over 50% full and / or is
very fragmented. It is reccommended that the hard drive of the acquisition computer is
defragmented on a regular basis including defragmenting the MFT of Windows 7 or
Windows XP using the supplied Diskkeeper software. Fix Information:

n/a

KPR#: 14334 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: 1700 m/z mass wrap-around causes calibration failure in 1700 mass range
during FPS One-line Description:

Problem:

1700 m/z mass wrap-around causes calibration failure in 1700 mass range during
FPS Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14336 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: Custom Defined Wellplates Cause Sample Position Error One-line
Description:

Problem:

It is possible to define and edit a custom wellplate using the Define and edit Wellplates
dialog. Once you select a custom wellplate though, it is impossible to do an injection
due to an error on sample position. This error occurs in both worklist and single sample
run. Temporary Solution:

n/a Fix Information:

n/a



KPR#: 14337 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.01

Keyword: "Error in App_Workbook open" seen while closing the report One-line
Description:

Problem:

1)Load a method. 2) Click on File->Print->Acquisition Method menu 3) Check “Screen”
option and click Ok Report gets generated successfully, however “Error in
App_Workbook open” is seen when we close the Print Preview. Temporary Solution:
The user must make sure that Reporting Add-Ins are correctly configured and activated
in Excel 2007. Fix Information:

n/a

KPR#: 14338 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.01

Keyword: Injection valve cleaning leaves valve in bypass position at end of run One-
line Description:

Problem:

| was using the injection valve cleaning procedure on my G1367C HiP ALS. Tab . The
valve is switched multiple times between the mainpass and bypass positions. Normally,
this procedure is done at the end of a run when the LC mobile phase is at high organic
composition so that the organic solvent will dissolve anything left in the injection valve.
In this procedure, every time this valve switches to the mainpass position, some mobile
phase of high organic composition is admitted to the sample loop. If these "plugs" of
high organic content mobile phase are left in the sample loop, then the next injection will
be poor because the sample will be washed off the column. This means, the sample
loop must be set back to mainpass and flushed as part of the column equilibration prior
to the start of the next run. Unfortunately, after this injection valve cleaning procedure is
completed, the injection valve is left in the bypass position at the end of the run.
Therefore, no flushing of the sample loop occurs, and the next injection is messed up.
When injection valve cleaning is requested and valve switching is enabled with nonzero
values, the injection valve should be returned to the mainpass position at the stop run
time so that the sample loop can be flushed. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14339 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.04.00

Keyword: APPI Cable has changed and is no longer compatible with the TOF and



QTOF products One-line Description:

Problem:

Due to either a procurement change or the vendor no longer making the old USB to
serial converter cable, the replacement cable no longer works with the TOF and QTOF
products. While this may be a hardware problem, the software/firmware team has
investigated the issue and determined that the new cable has the wrong chip set which
results in the incompatibility. This problem affects any TOF or QTOF with a new APPI
source. The new cable is visibly shorter when compared to the old cable. Temporary
Solution:

n/a Fix Information:

The short cable will not work and requires the customer to request a replacement cable.
Please contact Agilent Customer Support for more details.

KPR#: 14340 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.03.01

Keyword: Split Peaks are observed during acquisition One-line Description:

Problem:

The peaks were split on the acquisition board. Tune could not resolve the issue. Power
cycled the instrument and the resolution returned. Something is causing the FPGAs on
the Acquisition board to get locked up. Temporary Solution:

n/a Fix Information:

This issue was fixed with the release of Service Pack 2 for B.04.00 MassHunter
Acquisition for TOF and Q-TOF. Service Pack 2 updates the instrument firmware and
MassHunter Acquisition software to fix the defect. Any customer experiencing this issue
must upgrade to MassHunter Acquisition B.04.00 SP2 or higher.

KPR#: 14341 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00
SP1

Keyword: Sign on Funnel Voltage Drop Set Point Does Not Change When Switching
Polarity One-line Description:

Problem:
The user was running samples in positive polarity with a Funnel Voltage Drop of 150
volts. The user then change to negative polarity and went to change the Funnel Voltage



Drop to a lower voltage. There was no plus or minus sign in front of the voltage setting.
In Negative ion, the user entered 100V but immediately got an error back saying "Invalid
Input Range -200 to 200. Current polarity is negative". The field for the voltage turned
pink. This causes confusion as the user should see a negative sign in negative ion
mode to indicate the correct voltage range or sign. Temporary Solution:

n/a Fix Information:

This defect was fixed with the release of Service Pack 2 for B.05.00. However, for the
system to reflect the correct values, the existing tune file must be deleted and the
instrument retuned from defaults. Only then, will the values for the High Pressure and
Low Pressure Funnel Drops have the correct signs.

KPR#: 14342 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00
SP1

Keyword: Incorrect Error Message Displayed When a Leak Happens One-line
Description:

Problem:

The user had a leak in the column compartment. The system stopped and displayed the
error message "Starting analysis aborted via CAN". The MassHunter logbook displayed
the same error message which means nothing to the end user. An error needs to be
captured by the logbook showing that the system had a leak in the TCC. The popup
message also needs to show the user what the fault is as well. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14343 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00
SP1

Keyword: Maximum Drying Gas Flow Fates for GC/APCI Source on 6550 is Too
Low. One-line Description:

Problem:

A customer has a 6550 and a GC/APCI source. The maximum drying gas flow rate is
too low for the 6550 with this source installed. The flow rates and temperatures need to
be checked for the 6550 and the GC/APCI source. Temporary Solution:

n/a Fix Information:

This defect was fixed with the release of Service Pack 2 for B.05.00 MassHunter
Acquisition.



KPR#: 14344 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00
SP1

Keyword: Poor Error Message Description When Using Solvent Bottle Filling
Feature One-line Description:

Problem:

The user activated the Solvent Bottle Filling monitoring for the 1290 solvent bottle.
When the bottle reached the level to trigger a fault and stop the analysis, the
masshunter logbook only captured that the system did not inject due to system not
ready during the 10 minute window. The only message reported was using the Ready
State Description in the actuals window. It reported "Solvent A1". Nothing else was
reported. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14345 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00
SP1

Keyword: Instrument Configuration Report Returning All Zeros For The G6550A
iFunnel Q-TOF LC/MS System One-line Description:

Problem:

The user ran the instrument configuration report from the Acquisition and Tune context.
The report returned the serial number for the G6550A iFunnel Q-TOF LC/MS System as
US00000000. This is not correct. While it is printed on the tune report, this serial
number must be printed on the instrument configuration report as well. The report is
returning the correct serial numbers for the LC modules present. Temporary Solution:
n/a Fix Information:

This defect was fixed with the release of Service Pack 2 for B.05.00.

KPR#: 14347 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: Incorrect Information in Error Pop Up Message Displayed for Tuning with
APCI Source. One-line Description:

Problem:



The error message for attempting an initial TOF tune with a APCI source is wrong. The
message says: Autotuning with a APCI is not supported. Please use a Dual ESI source.
You can enable Autotuning with an unsupported source in the Preferences Tab. This
message is confusing and not correct. Temporary Solution:

n/a Fix Information:

This message was fixed with the release of Service Pack 2 for B.05.00.

KPR#: 14348 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00
SP2

Keyword: With No Nitrogen Supply Sheath Gas Is Reading -2.4 L/min When There Is
No Supply One-line Description:

Problem:

The customer ran out of nitrogen and noticed that the Sheath Gas Flow is negative 2.4
L/min when there is no flow. This is not possible. Temporary Solution:

n/a Fix Information:

This defect was fixed with the release of Service Pack 2 for B.05.00.

KPR#: 14349 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00
SP2

Keyword: Unique Instrument IDs required for G6530B and G6540B One-line
Description:

Problem:

WIth the introduction of the G6530B and G6540B, these instruments are unique and
therefore must be identified as such. The tune reports and instrument configuration
reports must reflect that these instruments are different. Temporary Solution:

n/a Fix Information:

This issue was fixed with the release of Service Pack 2 for B.05.00. For the G6530B
and G6540B, Service Pack 2 for B.05.00 MassHunter Acquisition for TOF and Q-TOF
must be installed. Previous releases will not recognize these instrument types and will
not allow for the instruments to be configured.

KPR#: 14350 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: Pusher/Puller Faults at Instrument Power On One-line Description:



Problem:

When the instrument is first pumped down, the pusher and puller are reported to be
faulting. However, a simple power cycle of the 6550 clears the fault and stops it from
happening again. Temporary Solution:

n/a Fix Information:

This defect was fixed with the release of Service Pack 2 for B.05.00 MassHunter
Acquisition for TOF and QTOF. The actual fix is contained within the instrument specific
firmware. To confirm that the correct instrument firmware is installed, check that X.569
firmware is installed on the instrument.

KPR#: 14351 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00
SP2

Keyword: Label for Quad Temp Missing In Diagnostics Tab One-line Description:

Problem:

The label for the Quad Heater Temperature is missing in the Tune Context =>
Diagnostics Tab. Right now it is blank so the user does not know what that field is and
what is its purpose. Temporary Solution:

n/a Fix Information:

This defect was fixed with the release of Service Pack 2 for MassHunter Acquisition for
TOF and QTOF B.05.00.

KPR#: 14352 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.04.00
SP3

Keyword: In MassHunter Acquisition B.04.00, when the TOF or QTOF nitrogen gas
supply is turned off or runs out, the instrument faults and the high vacuum gauge is
turned off as part of this fault. One-line Description:

Problem:

When the QTOF nitrogen gas supply is turned off or runs out, the instrument faults.
However, the high vacuum gauge is turned off as part of this fault. China customer are
complaining because after several hundred on and off cycles, the TOF high vacuum
gauge burns out and must be replaced. This gauge is very expensive which is the major
problem. This behavior is not desired and must be fixed. The fault must be captured and
recorded by MassHunter logbook. The gauge must remain on at all times. Any fault that



turns off the high vacuum gauge other than an actual high vacuum fault must be
corrected and stop turning off the high vacuum gauge. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14353 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.04.00
SP3

Keyword: Sheath Gas Flow is negative 2.4 L/min when there is no flow One-line
Description:

Problem:

The customer ran out of nitrogen and noticed that the Sheath Gas Flow is negative 2.4
L/min when there is no flow. This is not possible. It appears that there is a problem with
the offset of the sheath gas setpoint or feedback. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14354 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.04.00
SP2

Keyword: Wrong MS/MS Acquisition rate One-line Description:

Problem:

When SP2 is installed, the MS/MS acquisiton rate is no longer correct. Temporary
Solution:

n/a Fix Information:

n/a

KPR#: 14355 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00
SP2

Keyword: Mass Range Missing from Tune Reports One-line Description:

Problem:



The mass range is missing from the tune report. This needs to be reported in the same
manner as the Acquisition mode is being reported. The mass range needs to be
reported for all mass ranges and all acquisition modes. Temporary Solution:

No current work around. Fix Information:

n/a

KPR#: 14356 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.01

Keyword: Cannot enter "No Injection” or enter negative 1 in the sample position field
when running in MS manual mode One-line Description:

Problem:

The customer has a G6550A without a HPLC system. They create a Worklist to run
samples. They cannot enter: "No Injection.” or enter -1 to tell the system to run the
worklist without injection samples. The field turn red. Temporary Solution:

The customer can work around this by entering the field as: " vial 1". Then the Worklist
will run. Fix Information:

n/a

KPR#: 14357 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00
SP2

Keyword: The User Interface Freezes when acquisition computer HDD is Full. Also, the
HPLC Keeps Running. One-line Description:

Problem:

Unintentionally, a Worklist was started with not enough space remaining on the
Acquisition computer fard drive. Upon reaching the limit of the hard drive, the User
Interface froze. This left the pumps of HPLC running. Temporary Solution:
Customers are reminded to check the remaining hard drive space of the Acquisition
computer before running a Worklist. Fix Information:

n/a

KPR#: 14358 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00
SP1

Keyword: Pause Between Tunes Checkbox Not Working With CheckTune One-line
Description:



Problem:

Reported by a customer: The Pause between tune checkbox does not work with

Checktune. This feature is needed to obtain the best calibration. This issue only

happens with the Single AJS source. It appears to work with the Dual ESI source
correctly. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14359 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: HPLC-Chip type cannot be defined in MassHunter Offline Method
Editor One-line Description:

Problem:

There is no way to open the configuration User Interface of the HPLC Chip Cube in the
Offline Method editor. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14360 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: Needle up action on context-sensitive menu for uWPS does not change to
needle down after action One-line Description:

Problem:

The user decided to move the needle on the 1100 uWPS to the up position so it could
clean it. They used the item in the context-sensitive menu for the uWPS to do this. That
worked fine. However, the menu item did not change to as it has in the past but
remained displaying . That means, the only way it can restore the needle to its correct
position is to reset the uWPS. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14361 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: Worklist allows same datafile name One-line Description:



Problem:

The same datafile name in a worklist warns regards overwritting, but still allows running
a worklist. In previous versions it was not allowed to use the same datafile

name. Temporary Solution:

Customers should not use the same datafile names when running worklists. Fix
Information:

n/a

KPR#: 14362 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: Cancel worklist will automaticall switch the worklist window to Method Editor
window One-line Description:

Problem:

1. Open a worked method, set pump run time as one min, save it. 2. Open Worklist
window, set two samples. 3. On the top window menu, click run Worklist button. 4.
When a message box comes up, click Cancel button. 5. The current Worklist window is
automaticall switched to Method Editor with message for Method Editor

window. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14363 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: Worklist Run was not allowed even though worklist was valid One-line
Description:

Problem:

The user made a run in locked mode and then unlocked the console. Then they took
two sample runs and this created 2 new data files in unlocked mode. They then
selected these data files acquired in unlocked mode in worklist and tried to take Worklist
run in unlock mode. It gave a message that data files cannot be overridden in the locked
mode. After restarting the user interface, the issue was not reproducible. Temporary
Solution:

If the user experiences this behavior, restart the User Interface to resolve the

problem. Fix Information:

n/a



KPR#: 14364 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: DA Reprocessor - No error indication when the data file is not existed One-
line Description:

Problem:

1. Run a worklist with DA method to have data files ready. 2. Open DA-Reprocessor to
load this worklist file. 3. Select Edie Samples by right click on the cell which is the first

cell under Data File column. 4. Click OK to close the Edie Samples dialog. 5. The data
file has been changed as "WorklistData.d", but no error indication. It should show error
indication since the data file is not existed. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14365 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: Selection box shows a worklist name, but the worklist is not loaded. One-line
Description:

Problem:

1. Make sure that the worklist directory has some *.wkl files, one of them (say named as
1000old.wkl) is not supported by current version. 2. Load 1000old.wkl file to get a
message say the file is not selected. It is correct. 3. Another workable worklist file is
automatically selected in the selection box. 4. The worklist is empty. Temporary
Solution:

n/a Fix Information:

n/a

KPR#: 14366 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: Nano LC Pump Icon Yellow with all Modules Green One-line Description:

Problem:

The user purged the system thoroughly, so thoroughly that they went away for a
half/hour so the spray would be nice and predictable. When they got back to the Chip
LC enabled system, the Nano pump device image was yellow although all parameters
were acceptable and the Actuals displayed no wait states at all. They did not attempt an



acquisition, instead the system was shut off using the off button then turned back on.
Once the pump flow criteria was met (+/- 3%) in micro flow the device image turned
green as expected. This is a Once/Sporadic issue. Temporary Solution:

Restart the User Interface. Fix Information:

n/a

KPR#: 14367 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: DA Reprocessor - Need to click two times on the No button to close the
messagebox One-line Description:

Problem:

1. Launch DA Reprocessor, and load a worklist. 2. On Data File -> Path section, Enter a
valid non-existing path and click OK button. 3. Get a messagebox saying do you want to
create the path. 4. Click No, nothing happens. 5. Click No again, the messagebox will
closed. The messagebox should be closed when the No button is clicked. once

only. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14368 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: CTC May Hang in Prerun stage. One-line Description:

Problem:

1. Launch Masshunter with a Worklist loaded. 2. Wait to all devices are in ready state
except Q-TOF. For example, the QTOF is adjusting Temp. 3. F4 to run the worklist. 4.
When CTC in the Prerun state, and QTOF is still in adjusting state (yellow), Stop the
worklist run. 5. The CTC will hangs on Prerun state; Injector image animation keeps
showing injecting. Only way to out is kill Masshunter and re-start. Temporary Solution:
The user must close the User Interface and restart the engines. Fix Information:

n/a

KPR#: 14369 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: Save Layout input field not highlighted when prompt is presented One-line
Description:



Problem:

The text field in save layout is not highlighted when the prompt appears, The user
should not have to first mouse click the field in order to enter a layout title. Temporary
Solution:

n/a Fix Information:

n/a

KPR#: 14370 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: Study Manager - Showing "Acquisition in Progress" after completed run or
after stopped. One-line Description:

Problem:

1. Launch Masshunter and open Sample Run Window by clicking Sample Run tab. 2.
Launch Study Manager and submit a worklis-only job. 3. Start theStudy job run. 4. After
the job completed, the Acuuisition in Progress is still showing. It should be

cleared. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14371 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: Improper Acquisition Method Report format for CTC and ADC One-line
Description:

Problem:

Improper Acquisition Method Report format for CTC and ADC. Heading font and color
does not match with font and color used for LC and MS. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14372 Product: QTOF/TOF Acquisition  QTOF/TOF Acquisition B.05.00

Keyword: Don't hide menus when the "corresponding” window is hidden One-line
Description:



Problem:

When the user hide the Worklist window, the "Worklist" menu is also hidden. When the
user hide the Method Editor window, the "Method" menu is also hidden. Hiding items
instead of "graying" them out makes the User Interface confusing. If these menus really
shouldn't be available when the window is hidden, then these menus should be grayed
out. The menus should always be available; if a user does an action that requires a
window to be showing, then automatically show that window for the user. Temporary
Solution:

n/a Fix Information:

n/a

KPR#: 14373 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: "Save method" acts like "Save As" One-line Description:

Problem:

When you click the "Save method" icon in the method editor, it behaves like a "save as"
action - i.e., brings up the explorer box and makes you select the method - then asks if
you want to overright. The user believes the correct behavior should be to save any
changes to the loaded method without prompting for file name etc. Otherwise why have
"Save" when there is already a separate "Save as" icon. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14374 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: LC portion of acq method report takes too much space and has multiple
misspellings One-line Description:

Problem:

With an HPLC-Chip method on the 6550, a printed report looks great for MS section
(small but readable font, space utilized well) but the LC postion (2 pumps plus
autosampler) looks bad. Here are some of the problems: 1. Misspellings 2. Poor use of
space 3. Gratuitous lines diving parameters 4. A lot of parameters print out that
shouldn't (such as calibration on pump) 5. The pump gradient table, uses the hideous
functional layout instead of the nice, simple Time, %B, Flow, Pressure

layout. Temporary Solution:

n/a Fix Information:

n/a



KPR#: 14375 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: Excel formatting problems One-line Description:

Problem:

Print a method report to Excel, open the report and print it. - The right margin is too wide
and the header and separator lines do not fit on one page. - the page numbering is
wrong, all pages are numbered "page 1 of 1". The same thing happens with any report
generated to Excel, the page numbering is wrong and there are empty pages or pages
with overflow from previous page. Reports printed directly to printer are ok. Temporary
Solution:

n/a Fix Information:

n/a

KPR#: 14376 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: Signal definitions for non-MS signals gets lost if you close Acquisition One-
line Description:

Problem:

This defect was found by a peaked LC/MS FSE. The signal definitions for non-MS
signals are lost if you close Acquisition. This was also the case in previous
revisions. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14377 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: Offline DA reprocessor: Aborting run immediately after start still caused Qual
report to be generated for first sample One-line Description:

Problem:

During an offline DA reprocessor run, aborting run immediately after start will cause
Qualitative Analysis reports to be generated for first sample. Temporary Solution:
n/a Fix Information:

n/a



KPR#: 14378 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: Run start failed. Exception logged in Logbook by AcqgEngine One-line
Description:

Problem:

Configured LC MS QTOF device. Accidentally the LAN cable was removed from PC.
The instruments went to offline mode. The user reconnected the LAN and all
instruments came into green state. However clicking on "Run button” resulted into an
error message also exception logged in Logbook by AcqEngine for this. . This will be
also applicable to network connectivity issues. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14379 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: At the end of the method report, CTC parameters are not in readable
format. One-line Description:

Problem:

At the end of the Acquisition method report, there are some CTC parameters that are in
unreadable format. Either they need to be formatted correctly or removed. Temporary
Solution:

n/a Fix Information:

n/a

KPR#: 14380 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: Clicking on the MassHunter Acquisition Icon in Method Migrator Brings Up
Empty Pane One-line Description:

Problem:

Open the Method Migrator tool. Click on the Acquisition icon in the upper left corner. A
small empty pane opens up. Temporary Solution:

n/a Fix Information:

n/a



KPR#: 14381 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: Open the Method Migrator Tool Has Garbled Text One-line Description:

Problem:

Launch the Aquisition Console. Click on menu "Worklist -> Import Worklist..." to launch
"Import Worklist" dialog. When this dialog gets displayed it has two radio buttons, which
has garbled text. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14382 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: When Using Overlapped Injection After a Period of Time the Pump Stop
Time is Allowed One-line Description:

Problem:

The user was able to create a method and enable overlapped injection with a period of
time greater than the pump stop time. The HPLC went into wait mode (purple) until the
overlapped injection time was reached. This should not be allowed. The user should be
given a warning or maybe the instrument should show an error. Temporary Solution:
n/a Fix Information:

n/a

KPR#: 14383 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: Open data file folder dialog is not consistent with normal explorer behaviour
of sorting data file on basis of Name. One-line Description:

Problem:

Prerequisite: Create around 120 data file incrementally like WKL 1.d, WKL 2.d..... 1)
Open MassHunter application. 2) Select worklist pane and open "Open data file" dialog
from data file column. Verify that sorted data is not according to normal behaviour of
explorer where data is sorted properly however in "Open data file" dialog it is WKL 1.d,
WKL 10.d, WKL 100.d. Temporary Solution:

n/a Fix Information:



n/a
KPR#: 14384 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.04.00

Keyword: New Directed Auto MS/MS Mode Not Indicated in Acquisition Report One-
line Description:

Problem:

The user created a method with the directed mode enabled (autoMS/MS, "use preferred
ion list only" checkbox is enabled in the Preferred/Exclude tab). The table of ions is
present, but there's no indication that these ions are the only ones to be

used. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14385 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.04.00

Keyword: LC method report is not consistent with setpoints in User Interface One-line
Description:

Problem:

Following shows the observations when LC setpoint Uls are compared with method
report generated. ALS, WPS and pWPS: - Report doesn’t show “Store temperature”
field. On setpoint Ul, it is on “Options” tab under “Auxiliary” tab. WPS: - Report field
caption for “Vial/Well bottom sensing” field is “Draw Position Detection”. 1290 Sampler
(G4226A): - Report doesn’t show fields from “Enable Needle Seat Back Flush” group
box. - This group box includes the fields Enable Needle Seat Back Flush, Solvent 1,
Solvent 2, Start Cond., Flow, Duration. WPS, pWPS: - Report doesn’t show Carryover
reduction settings (rinse settings, fields from “Clearing Wellplate Sampler” group box).
CTC: - Report doesn’t show “Syringe” field. - Report shows “Injection Type” value in
numeric For example, -4. NanoPump: - Report doesn't show “StrokeB” if it's value is
"Auto". QuatPump: - Value for "Primary Channel" is in numeric. On Setpoint Ul it has
text value like "Auto”, "A", "B", etc. TCC: - Report doesn’t have field for Store:
Temperature (left), Temperature (right) parameters. G1316C TCC.: - Setpoint Ul has
field for “Enable door open check”, report doesn’t show it. DAD: - Report doesn’t show
signal store option, spectrum store options. - No unit for “Slit”. - No unit for “Margin for -
ve absorbance”. G4212B DAD: - For G4212B Slit is not applicable, report still shows slit
with value 4. - Also analog output 2 and vis lamp and fields are hidden for G4212B
however those are included in report. ADC: - Unit for “Date Rate” field on setpoint Ul is
“Hz”, however report shows the value in “ms” unit. - Setpoint Ul field “Units/Volt” from



‘Signal Settings’ group box is mapped to “Y-axis Range” in report. This might be
confusing. Also, field “Signal Units/Volts” from report doesn’t exists on setpoint UI.
VWD: - Report doesn't show "Delay" field. "To", "From", "Step" fields are not on Setpoint
Ul. however, report still shows them. - Special setpoints tab: Signal polarity is not shown
in report. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14386 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.04.00

Keyword: Server Busy One-line Description:

/ Message Displayed When LAN Cable Accidently Unplugged

Problem:

Inadvertently the LAN connection to the LC was disconnected while starting
MassHunter. The error message "Server Busy" was displayed. Temporary Solution:
Use the "Stop MassHunter Processes" tool to recover the system. Fix Information:
n/a

KPR#: 14387 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.03.01

Keyword: Hex 3DC should be listed in Optics 2 section One-line Description:

Problem:

In the tune report, Hex 3DC is currently in the Cell section. It should be moved to Optics
2. Temporary Solution:

n/a Fix Information:

Fixed with the release of B.04.00.

KPR#: 14388 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.02.00

Keyword: 4GHz HiRes Quick Tune Report shows 4GHz HiRes Disabled mode One-
line Description:

Problem:

Put instrument in 4GHz HiRes mode, run Quick Tune, and you'll get a report that says
"4GHz HiRes Disabled" instead of "4GHz HiRes". The instrument has been properly
optimized, it's just that the report shows the wrong mode. The problem is that the



instrument state isn't properly restored before the report is produced. Temporary
Solution:

n/a Fix Information:

This was fixed with the relese of B.04.00 MassHunter Acquisition for TOF and QTOF.

KPR#: 14389 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: Acquisition Method Report Does Not Include Information on the Data
Analysis Tab One-line Description:

Problem:

The user printed a method (click File > Print > Method Report). It was sent to the
screen. The user expected the report to include information on the DA tab (the Qual
check box was marked). The report didn't include any information on the DA tab. This
tab is PART of the method, so it should be documented in the method

report. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14390 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: Too Many Prompts To User When Switching Context One-line Description:

Problem:

The user switched to Tune context, checked the version of MH at the Help menu. They
then remembered they had to do something in Acquisition context, so they select the
drop menu/Acquisition context. "Layout has changed, save changes"? prompt
appeared. Clicked No. Follow that up with "Save the tune file"? prompt appeared.
Clicked No. Three prompts to leave tune context is unacceptable, especially since the
layout never did change. The layout prompt is random, sometimes it happens and
sometimes it does not.. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14391 Product: QTOF/TOF Acquisition  QTOF/TOF Acquisition B.04.01

Keyword: Sample Name Number of Characters Is Very Limited in Acqusition One-line
Description:



Problem:

The character space for the sample name in acqusition is too small. Should be longer at
least 2 times. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14392 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: The User Needs to Press One-line Description:

Twice to Add New Chromatogram to Real Time Plot ( RTP)

Problem:

1. Select the MS-QTOF/Chromatogram tab. 2. Right-click and select Add 3. Click (TIC
signal is added to the RTP) 4. Add another signal, change the name to TIC 2 5.

Click TIC 2 does not appear in the RTP. The user must click a second time. Temporary
Solution:

n/a Fix Information:

n/a

KPR#: 14393 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: Migration of a QTOF method to TOF resets parameters to default One-line
Description:

Problem:

Migration of a QTOF method written on B.00.4 to a TOF with B.05.00 resets parameters
to default values. This was found when a negative QTOF method would be reset to
positive after the migration, an APCI method would be reset to default ESI. Temporary
Solution:

Users should carefully examine any migrated methods for incorrect set points. Fix
Information:

n/a

KPR#: 14394 Product: QTOF/TOF Acquisition  QTOF/TOF Acquisition B.05.00

Keyword: Optimization window is minimized during ramping One-line Description:



Problem:

The Optimization window should be displayed during ramping, not
minimized. Temporary Solution:

This defect has to do with Windows 7 and refreshing the real time plot. Once
maximized, the ramp plot will stay on top as it should. Fix Information:

n/a

KPR#: 14395 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.01

Keyword: Single AJS is Not a Support Tune Source Type One-line Description:

Problem:

Reported by a customer: The customer has a 6540 with a single AJS source. They were
under the impression that this was a supported source for tuning. Product Support was
also under the impression that this source type is now supported for tune since the Dual
AJS is supported. Temporary Solution:

Customers can use the advanced feature to enable tuning on all sources. Fix
Information:

n/a

KPR#: 14397 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00
SP1

Keyword: TIC plot in Tune Context Removed in the B.05.01 SP1 One-line
Description:

Problem:

The customer uses TIC real time plot in tune context in order to check tune parameters
and sprayer setting. Before MassHunter upgrade, the customer could use this feature.
But after TOF ACQ Mass Hunter upgrade from B.04.00 to B.05.01SP1, they could not
use this function because the TIC plot pane itself is deleted in tune context menu on
ACQ B.05.01SP1 version. Temporary Solution:

n/a Fix Information:

This issue was fixed with the release of MassHunter Acquisition for TOF and Q-TOF
B.06.00

KPR#: 14398 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.00

Keyword: lon Optics Element Enabled on 6224/6230 that should not be present One-



line Description:

Problem:

In the Manual Tune tab of the 6224, in the lon Optics tab, there are two items "Len 2 DC
Optimal Ramping" and "Lens 2 RF Optimal Ramping" that appear to users. These menu
items control ion optics elements that are not even in the TOF. While it is not a
showstopper defect, the user is asking how to enable them and what do they gain.
Confirmed on a 6224 and probably seen on the 6230 as well. Temporary Solution:

n/a Fix Information:

This is was fixed with the release of MassHunter Acquisition for TOF and QTOF B.06.00

KPR#: 14399 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.01
SP1

Keyword: Failure of Quad Tune Due to QuadAMU Set to 200 AMU by Tune
Algorithm. One-line Description:

Problem:

Tune Algorithm Sets QuadAMU to 200 early in the process. Shortly after this, a mass
calibration is done, and there may not be enough 118 ion present for a good calibration.
Thus, in subsequent tuning of components, poor mass accuracy prevents the
monitoring of a specific mass to evaluate ramps of those components and the Quad
Tune will fail. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14400 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.06.00

Keyword: Changes to Values via Advanced Parameter Tab May not be Saved if The
Dropdown Show Category List is Changed After Changing Values One-line
Description:

Problem:

When editing a method in the Q-TOF -> Advanced Parameters tab, making changes to
the Show Category drop down box can prevent changes from being saved. If you
choose a category, then change to another category, only changes to the currently
showing category are saved. Using the All category prevents this. Temporary Solution:



Using the All category prevents this problem from occurring. Fix Information:
n/a

KPR#: 14401 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.06.00

Keyword: When operating the 6560 in IM-mode in negative polarity, the system isn't
able to ramp the trap grid delta parameters. One-line Description:

Problem:

When operating the 6560 in IM-mode in negative polarity, the system isn't able to ramp
the trap grid delta parameters. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14402 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.06.00

Keyword: System Hangs in Pre-run State During First Injection After Instrument Off/On
Cycle One-line Description:

Problem:

Power cycling the system may result in the Q-TOF not initializing properly for the next
injection. The system will hang in a Pre-run state. Temporary Solution:

Stopping the injection or worklist will allow the next injection to occur normally. Fix
Information:

n/a

KPR#: 14403 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.01
SP1

Keyword: Spectral Parameters not Modifiable in Offline Method Editor One-line
Description:

Problem:

Spectral acquisition rates and parameters are not adjustable in the offline method editor
software. Temporary Solution:

Modify spectral parameters in the online Acquisition software. Fix Information:

n/a



KPR#: 14404 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.06.00

Keyword: Disagreement between Instrument Actuals Readback and Method Tab
Settings One-line Description:

Problem:

The Instrument Actuals window can be configured to display many system voltages.
There are some inaccuracies displayed here on some of the IM parameters. Temporary
Solution:

Inspect IM voltages in the Manual Tune context. Fix Information:

n/a

KPR#: 14405 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.06.00

Keyword: Readback values for Q-TOF parameters and IMS not accessible from datafile
in Qual One-line Description:

Problem:

In Qual, no IM voltage settings are displayed when reviewing the MS
Actuals. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14406 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.06.00

Keyword: lon Souce device image does not turn red when incorrect ion source is
selected One-line Description:

Problem:

If an ion source that is not currently installed is selected in the method editor, there is no
indications of incompatibility with the currently installed source. If you try to run the
method, it will throw an error stating incorrect source type. Temporary Solution:

Confirm visually that the correct source is installed on the system as is specified in the
method. Fix Information:

n/a



KPR#: 14407 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.06.00

Keyword: Realtime EIC does not perfectly represent the data being collected. One-line
Description:

Problem:

At low intensities, an EIC being displayed in the Acquisition Real Time Display does not
accurately reflect the intensity of the extracted ion. Temporary Solution:

If you extract the same EIC in Qualitative Analysis, you will see the true ion

intensities. Fix Information:

n/a

KPR#: 14408 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.06.00

Keyword: High RF Values on HP, Trapping, and Rear Funnel Can Reduce 118 lon
Abundance and Cause Quad Tune to Fail One-line Description:

Problem:

If the user has set the RF values to high values, such as 200 Vpp, it can diminish the
abundance of the 118 ion. The Quad Tune can then fail to pass. Temporary Solution:
If Quad tune is having trouble passing, the 118 ion is very low abundance, and the RF
values are around 200 Vpp, lower them to 150 Vpp. Fix Information:

n/a

KPR#: 14410 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.06.00

Keyword: IM-Browser Performance Slows After Several Data File Analyses One-line
Description:

Problem:

If you open many data files in sequence without closing the IM-Browser, performance
can slow. Temporary Solution:

Close and reopen the IM-Browser if performance slows. Fix Information:

n/a

KPR#: 14412 Product: QTOF/TOF Acquisition  QTOF/TOF Acquisition B.05.01
SP1



Keyword: Initial Autotune Fails with Error Message Stating No Peaks Found One-line
Description:

Problem:

Autotune is failing when the 118 ion is not present due to the QuadAMU parameter
being set too high during the autotune. Temporary Solution:

n/a Fix Information:

n/a

KPR#: 14413 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.01
SP1

Keyword: Nozzle Voltage Cannot be Changed in Worklist One-line Description:

Problem:

Despite having a column specifying the nozzle voltage, there is no effect when a value
is entered into this field of the worklist. Temporary Solution:

Specify the nozzle voltage in the method being used. Fix Information:

n/a

KPR#: 14414 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition B.05.01
SP1

Keyword: 40 Spectra per Second In Extended Dynamic Range Not Available in B.05.01
for G6224A/G6230A/B TOF One-line Description:

Problem:

Customer's method call for 40 spectra per second with no polarity switching. They
upgraded their software from MassHunter Acquisition B.02.01 to MassHunter
Acquisition B.05.01. With the old software, they had this feature. With the new software,
they can only acquire 33 spectra per second before the software goes pink and will not
allow the field to be updated. The customer found that if they put the system in High
Resolution Mode, the software will allow them to input 40 spectra per second. However,
they require Extended Dynamic Range for their method. Temporary Solution:

n/a Fix Information:



This issue was fixed with the release of Service Pack 2 for MassHunter Acquisition for
TOF and QTOF B.05.01.

KPR#: 14415 Product: QTOF/TOF Acquisition QTOF/TOF Acquisition Future

Keyword: Default fragmentor voltage not optimum for autotune in negative mode One-
line Description:

Problem:

The problem only occurs with TOF system, where the system lacks the quadrupole
optics (especially collision cell to cool down the ions). In order to increase sensitivity for
low mass ions, the ion fragmentor (currently set at 190V) should be set at 165V. In
positive mode, the appropriate compensation for our TOF systems was implemented
correctly (the default value was already reduced from 215V to 175V in previous
software release). Temporary Solution:

n/a Fix Information:

Change the default value for Fragmentor in negative ion mode from 190V to 165V and
changing SW to load the optimal value after Autotune has been completed.
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